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1. Overview of the Early Power Estimator for Intel®
Stratix® 10 Devices

This user guide describes the Early Power Estimator (EPE) for Intel® Stratix® 10
devices.

This user guide provides guidelines for using the EPE, and details about thermal
analysis and the factors contributing to FPGA power consumption. You can calculate
FPGA power consumption using the Microsoft Excel*-based EPE spreadsheet. For more
accurate power estimation, use the Power Analyzer in the Intel Quartus® Prime
software.

Intel recommends that you switch from the EPE spreadsheet to the Power Analyzer in
the Intel Quartus Prime software once your design is available. The Power Analyzer
produces more accurate results because it has more detailed information about your
design, including routing and configuration information about each of the resources in
your design.

Intel recommends using the EPE results as an estimate of power, not as a
specification. You must verify the actual power consumption during device operation,
because the information is sensitive to the actual device and design input signals. See
the appendix Measuring Static Power for information on how to measure device static
power in a way that correlates with the way that EPE reports static power.

The features of the EPE spreadsheet include:

• Ability to estimate the power consumption of your design before creating the
design or during the design process

• Ability to import device resource information from the Intel Quartus Prime
software into the EPE spreadsheet with the use of the Intel Quartus Prime-
generated EPE file

• Ability to perform preliminary thermal analysis of your design

1.1. Intel Stratix 10 EPE Power Model Status

The power models in the Early Power Estimator (EPE) for Intel Stratix 10 devices can
be in advance, preliminary, or final status.

Advance power models are based on simulation results, process model projections,
and design targets. Preliminary power models include post-layout simulation results,
process data, and initial silicon correlation results. Advance and preliminary power
models may change over time. Final power models correlate to production devices
with thousands of designs, and are not expected to change. The Main worksheet of
the EPE spreadsheet shows power model status for the selected device.

The accuracy of the power model is determined on a per-power-rail basis for both the
Power Analyzer and the Early Power Estimator. For most designs, the Power Analyzer
and the EPE spreadsheet have the following accuracies, with final power models:

683175 | 2021.12.03

Send Feedback

Intel Corporation. All rights reserved. Intel, the Intel logo, and other Intel marks are trademarks of Intel
Corporation or its subsidiaries. Intel warrants performance of its FPGA and semiconductor products to current
specifications in accordance with Intel's standard warranty, but reserves the right to make changes to any
products and services at any time without notice. Intel assumes no responsibility or liability arising out of the
application or use of any information, product, or service described herein except as expressly agreed to in
writing by Intel. Intel customers are advised to obtain the latest version of device specifications before relying
on any published information and before placing orders for products or services.
*Other names and brands may be claimed as the property of others.

ISO
9001:2015
Registered

mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20Early%20Power%20Estimator%20for%20Intel%20Stratix%2010%20FPGAs%20User%20Guide%20(683175%202021.12.03)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.
https://www.intel.com/content/www/us/en/quality/intel-iso-registrations.html
https://www.intel.com/content/www/us/en/quality/intel-iso-registrations.html
https://www.intel.com/content/www/us/en/quality/intel-iso-registrations.html


• Power Analyzer: Within 10% of silicon for the majority of power rails and the
highest power rails, assuming accurate inputs and toggle rates.

• EPE spreadsheet: Within 15% of silicon for the majority of power rails and the
highest power rails, assuming accurate inputs and toggle rates. Recommended
margins are shown in the report tab (see Report tab section).

See Section 5 for information on factors impacting power estimation accuracy.

Related Information

Factors Affecting the Accuracy of the Early Power Estimator on page 53

1.2. Definitions of Power Terms Used in this Document

The total power consumption of an Intel Stratix 10 device consists of the following
components:

• Static power—the power that the configured device consumes when powered up
but no user clocks are operating, excluding DC bias power of analog blocks, such
as I/O and transceiver analog circuitry.

• Dynamic power—the additional power consumption of the device due to signal
activity or toggling.

• Standby power—the component of active power that is independent of signal
activity or toggling. Standby power includes, but is not limited to, I/O and
transceiver DC bias power.

1. Overview of the Early Power Estimator for Intel® Stratix® 10 Devices
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2. Setting Up the Early Power Estimator for Intel Stratix
10 Devices

2.1. System Requirements

The Early Power Estimator for Intel Stratix 10 devices requires the following software:

• Windows operating system

• Microsoft Excel* 2003, Microsoft Excel 2007, or Microsoft Excel 2010

• Intel Quartus Prime software that supports the target device (if generating a file
for importation)

2.2. Download and Install the Early Power Estimator for Intel
Stratix 10 Devices

The Early Power Estimator (EPE) for Intel Stratix 10 devices is available from the Early
Power Estimators and Power Analyzer page on the Intel FPGA website.

After you read the terms and conditions and click I Agree, you can download the
Microsoft Excel* (.xls or .xlsx) file.

By default, the macro security level in Microsoft Excel 2003, Microsoft Excel 2007, and
Microsoft Excel 2010 is set to High. If the macro security level is set to High, macros
are automatically disabled. For the features in the EPE spreadsheet to function
properly, you must enable macros.

Related Information

Early Power Estimators and Power Analyzer

2.2.1. Changing the Macro Security Level in Microsoft Excel* 2003

To change the macro security level in Microsoft Excel 2003, follow these steps:

1. Click Tools ➤ Options.

2. Click Security ➤ Macro Security.

3. Select Security Level ➤ Medium in the Security dialog box then click Ok.

4. Click Ok in the Options window.

5. Close the Early Power Estimator spreadsheet and reopen it.

6. Click Enable Macros in the dialog box.

683175 | 2021.12.03

Send Feedback

Intel Corporation. All rights reserved. Intel, the Intel logo, and other Intel marks are trademarks of Intel
Corporation or its subsidiaries. Intel warrants performance of its FPGA and semiconductor products to current
specifications in accordance with Intel's standard warranty, but reserves the right to make changes to any
products and services at any time without notice. Intel assumes no responsibility or liability arising out of the
application or use of any information, product, or service described herein except as expressly agreed to in
writing by Intel. Intel customers are advised to obtain the latest version of device specifications before relying
on any published information and before placing orders for products or services.
*Other names and brands may be claimed as the property of others.

ISO
9001:2015
Registered

https://www.intel.com/content/www/us/en/programmable/support/support-resources/operation-and-testing/power/pow-powerplay.html
mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20Early%20Power%20Estimator%20for%20Intel%20Stratix%2010%20FPGAs%20User%20Guide%20(683175%202021.12.03)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.
https://www.intel.com/content/www/us/en/quality/intel-iso-registrations.html
https://www.intel.com/content/www/us/en/quality/intel-iso-registrations.html
https://www.intel.com/content/www/us/en/quality/intel-iso-registrations.html


2.2.2. Changing the Macro Security Level in Microsoft Excel 2007

To change the macro security level in Microsoft Excel 2007, follow these steps:

1. Click the Office button in the upper left corner of the .xlsx file.

2. Click the Excel Options button at the bottom of the menu.

3. Click the Trust Center button on the left. Then, click the Trust Center Settings
button.

4. Click the Macro Settings button in the Trust Center dialog box. Turn on the
Disable all macros with notification option.

5. Close the Early Power Estimator spreadsheet and reopen it.

6. Click Options when a security warning appears beneath the Office ribbon.

7. Turn on Enable this content in the Microsoft Office* Security Options dialog
box.

2.2.3. Changing the Macro Security Level in Microsoft Excel* 2010

To change the macro security level in Microsoft Excel 2010, follow these steps:

1. Click File

2. Click Help ➤ Options

3. Click Trust Center ➤ Trust Center Settings

4. Click the Macro Settings button in the Trust Center dialog box. Turn on the
Disable all macros with notification option.

5. Close the Early Power Estimator spreadsheet and reopen it.

6. Click Enable Content when a security warning appears beneath the Office ribbon.

2.3. Estimating Power Consumption with the Intel Stratix 10 Early
Power Estimator

With the Early Power Estimator (EPE) for Intel Stratix 10 devices, you can estimate
power consumption at any point in your design cycle. You can estimate the power
consumption when you have not yet begun your design, or if your design is partially
complete. Although the EPE can provide a power estimate for your completed design,
Intel recommends that you use the Power Analyzer in the Intel Quartus Prime
software instead, for a more accurate estimate based on the exact placement and
routing information of the completed design.

2. Setting Up the Early Power Estimator for Intel Stratix 10 Devices
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2.3.1. Estimating Power Consumption Before Starting the FPGA Design

Table 1. Advantage and Constraints of Power Estimation before Designing FPGA

Advantage Constraint

• You can obtain power estimates before starting your
FPGA design.

• You can adjust design resources and parameters and see
how those changes affect total power consumption.

• Accuracy depends on your inputs and your estimate of
the device resources; where this information may
change (during or after your design is complete), your
power estimation results may be less accurate.

• The Early Power Estimator spreadsheet uses averages
and not the actual design implementation details. The
Power Analyzer has access to the full design details. For
example, the EPE uses average values for ALM
configuration, while the Power Analyzer specifies an
exact configuration for each ALM.

To estimate power consumption with the EPE spreadsheet before starting your FPGA
design, follow these steps:

1. On the Main worksheet of the EPE spreadsheet, select the target family, device,
and package from the Family, Device, Device Grade, Package, and
Transceiver Grade drop-down lists.

2. Enter values for each worksheet in the EPE spreadsheet. Different worksheets in
the EPE spreadsheet display different power sections, such as clocks and phase-
locked loops (PLLs).

3. The calculator displays the total estimated power consumption in the Total (W)
cell of the Main worksheet.

2.3.2. Estimating Power Consumption While Creating the FPGA Design

If your FPGA design is partially complete, you can import the Early Power Estimator
(EPE) file (<revision name>_early_pwr.csv) generated by the Intel Quartus Prime
software into the EPE spreadsheet. After importing the information from the EPE file
into the EPE spreadsheet, you can edit the EPE spreadsheet to reflect the device
resource estimates for your final design.

Table 2. Advantages and Constraints of Power Estimation if your FPGA Design is
Partially Complete

Advantage Constraint

• You can perform power estimation early in the FPGA
design cycle.

• Provides the flexibility to automatically fill in the Early
Power Estimator spreadsheet based on the Intel Quartus
Prime software compilation results.

• You can adjust design resources and parameters and see
how those changes affect total power consumption.

• Accuracy depends on your inputs and your estimate of
the device resources; where this information may
change (during or after your design is complete), your
power estimation results may be less accurate.

• The EPE spreadsheet uses averages and not the actual
design implementation details. The Power Analyzer has
access to the full design details. For example, the EPE
uses values for ALM configuration, while the Power
Analyzer specifies an exact configuration for each ALM.

2. Setting Up the Early Power Estimator for Intel Stratix 10 Devices
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Importing a File

To estimate power consumption with the EPE spreadsheet if your FPGA design is
partially complete, you can import a file.

Importing a file saves you time and effort otherwise spent on manually entering
information into the EPE. You can also manually change any of the values after
importing a file.

Generating the EPE File

To generate the EPE file, follow these steps:

1. Compile the partial FPGA design in the Intel Quartus Prime software.

2. On the Project menu, click Generate Early Power Estimator File to generate
the <revision name>_early_pwr.csv in the Intel Quartus Prime software.

Importing Data into the EPE Spreadsheet

You must import the EPE file into the EPE spreadsheet before modifying any
information in the EPE spreadsheet. Also, you must verify all your information after
importing a file.

Importing a file from the Intel Quartus Prime software populates all input values that
were specified in the Intel Quartus Prime software. Alternatively, you can import
values exported from an earlier version of the EPE spreadsheet.

Input values imported into the EPE spreadsheet are the values taken from the Intel
Quartus Prime software as per the design, or the values that were entered into an
earlier version of the EPE spreadsheet. After importing, you can manually edit the
values in the EPE spreadsheet to suit your changing design requirements.

To import data into the EPE spreadsheet, follow these steps:

1. On the Main worksheet of the EPE, click Import CSV.

2. Browse to an EPE file generated from the Intel Quartus Prime software or an
earlier version of the EPE spreadsheet and click Open. The file has the name
<revision name>_early_pwr.csv.

3. After the file is imported, the mouse cursor changes from busy to normal. If there
are any warnings during the importation, the EPE produces the EPE Import
Warnings dialog box. Analyze the warnings carefully to ensure that they are
expected. If any of the warnings are unexpected, you must manually modify the
corresponding fields in the EPE after the importation is completed. You can copy
all warning messages to the clipboard for future reference by clicking Copy to
Clipboard. Click OK to dismiss the EPE Import Warnings dialog box.

The following figure shows example warnings that may occur when importing a design
from the EPE spreadsheet. The first four error messages indicate that device ordering
codes have changed between the two families, so the previous values for Device
Grade, Device, Package and Transceiver Grade input fields could not be imported
directly, but were set to their default values instead. The last message indicates that
the VCC voltage value does not apply to the default device that was selected due to
the first four warning messages, so the voltage was set to its default value.

2. Setting Up the Early Power Estimator for Intel Stratix 10 Devices
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Figure 1. Example Warning Messages During Importation

2.3.3. Estimating Power Consumption After Completing the FPGA Design

If your design is complete, Intel strongly recommends using the Power Analyzer in the
Intel Quartus Prime software. The Power Analyzer provides the most accurate
estimate of device power consumption. The Power Analyzer uses toggle rates from
simulation, user assignments, and placement-and-routing information to provide
accurate power estimates.

2. Setting Up the Early Power Estimator for Intel Stratix 10 Devices
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3. Early Power Estimator for Intel Stratix 10 Graphical
User Interface

The graphical user interface (GUI) of the Early Power Estimator for Intel Stratix 10
devices consists of input fields for data entry, output fields for display of results and
messages, and buttons to trigger actions. Some fields can serve as both inputs and
outputs, and are referred to as input/output fields.

Most input and output fields have tooltips that explain the field's purpose. Fields with
tooltips have a red triangle in the top right corner of the field label. Hover your mouse
over the label to display the tooltip.

3.1. Intel Stratix 10 EPE Input Fields

Input fields let you enter information about the device, board, and design for which
you want to calculate power estimates. Some input fields let you type values directly,
and others let you select from a list of values on a dropdown menu.

Direct Entry Input Fields

Some fields allow you to type values directly into the field. Such fields are often used
for data that has a large range of possible values, such as clock frequencies or
resource counts.

If the value you enter does not pass legality checks, or is inappropriate for the field,
the system displays an error message. The error message may indicate the conditions
under which a value is invalid, and specify a valid range of values. An example
message is shown below. In this example the user has entered a temperature that is
outside the allowed range for a selected family, device, transceiver grade, device
grade and package combination. The error message also indicates the allowed range
of 0 to 100. After you click OK, the field reverts to its previous value.
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Figure 2. Example Error Message

If a specific type of numerical value is expected and you enter a text value or a wrong
numerical type, the resulting error message indicates that the entered value cannot be
converted to the expected data type. The following figure shows an example. In this
instance, a fractional value (37.5) has been entered in a field that expects an integer
value representing the number of RAM blocks. After you click OK, the field reverts to
its previous value.

Figure 3. Invalid Value Error Message

Many fields have restrictions based on the selected family and device. To better
understand restrictions on field values, refer to the relevant field description in this
user guide, to the tooltip in the appropriate EPE worksheet, or to the Intel Stratix 10
Device Handbook.

Note: Although the Early Power Estimator restricts many field values, the restrictions are not
exhaustive. In order to provide power estimates at early design stages, when many
details of the design are still unknown, the EPE uses a simplified device model that
does not account for all possible restrictions. The EPE may accept as legal some values
that might not be accepted as legal by the Intel Quartus Prime software.

3. Early Power Estimator for Intel Stratix 10 Graphical User Interface
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Dropdown Input Fields

Input fields that have a limited number of valid values often employ a dropdown
menu. A dropdown menu is denoted by a downward-pointing arrow that appears when
you click in the field. Click in the field a second time to display the list of allowed
values. Click the desired value to select it and populate the field. An example
dropdown input field is shown in the following figure:

Figure 4. Dropdown Input Field

You can also type a value directly into an input field that has a dropdown menu. To
directly enter a value, select the field and press F2, and then type the desired value.
The value that you enter must be identical to one of the available values on the
dropdown menu, otherwise an error message occurs.

Figure 5. Value Entered is Not Valid

You can click Retry in the error dialog to enter a new value, or click Cancel to revert
back to the last legal value. Clicking Help invokes the generic Excel help window.

3.2. Intel Stratix 10 EPE Output Fields

Output fields display estimated values for power, current, temperature, or resource
utilization for a design specification that you have entered into the Early Power
Estimator.

Some output fields, such as thermal power estimates in the Main and Report
worksheets, may display values in red to indicate an error in the design specification.
If you encounter results displayed in red, review the relevant worksheet for errors or
utilization values exceeding 100%. Correct any errors to obtain reliable power and
temperature estimates.

3.3. Intel Stratix 10 EPE Input/Output Fields

Certain fields may serve as input fields in some configurations, and output fields in
others.

3. Early Power Estimator for Intel Stratix 10 Graphical User Interface
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For example, you may enter a Pin Clock Frequency value manually for some I/O
modes, while in other I/O modes Pin Clock Frequency is calculated automatically
based on values of other input fields.

If you enter a value into an input/output field when it is serving as an output, there is
no effect. The value reverts to the calculated value.

3.4. Intel Stratix 10 EPE Field Shading

The Early Power Estimator for Intel Stratix 10 devices employs shading to distinguish
between input and output fields, and to help identify fields with only one allowed
value.

Figure 6. Input Fields with Shading

Regular input fields, such as Device and Device Grade have white shading. White
shading also denotes input/output fields.

Input fields that currently have only one allowed value, such as Transceiver Grade in
this example, have gray shading. In this example, there is only one supported
transceiver grade for the selected combination of device, device grade and package. A
different combination of device, device grade and package may support more than one
transceiver grade, in which case the Transceiver Grade field shading would turn
white.

Output fields, such as Power Model Status, or PSTATIC have pale blue shading. Some
output fields, such as TOTAL (W), employ a darker shade of blue for emphasis.

3.5. Intel Stratix 10 EPE Input Field Dependencies

The value you specify for some input fields may affect the allowed values for other
fields.

For example, the device package that you select may determine what transceiver
grades are selectable. If you change the selected device package, and the currently
selected transceiver grade is still legal for the new package, the Transceiver Grade
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value does not change. However, if the currently selected transceiver grade is not
compatible with the selected device package, the Transceiver Grade value
automatically changes to one of the legal values.

Changes that you make in one worksheet may affect values on another worksheet,
because of dependencies between input fields. For example, if you select a device that
does not support the current I/O standard specified in the I/O worksheet, that I/O
standard automatically changes to one that is supported by the new device.

In general, the Early Power Estimator for Intel Stratix 10 devices does not
automatically change an input value unless it is necessary to preserve the legality of
the input. Changes in one field have minimal impact on other fields, while ensuring
that overall combination of field values are legal. However, this can sometimes lead to
unanticipated results. Consider the following example:

Assume that Dev1 is selected in the Main worksheet, and I/O standard IO1 is
selected in the I/O worksheet. Assume also that device Dev1 supports I/O standards
IO1 and IO2. Suppose that you change the device selection to Dev2, which supports
only one I/O standard, IO2. As a result of you changing the device selection, the I/O
standard in the I/O worksheet changes to IO2. If you then reverted the device
selection back to Dev1, the I/O standard does not change, because IO2 is a legal I/O
standard value for the device Dev1. The important point to note, is that the changing
of device from Dev1 to Dev2 and back again, had the—potentially unintended—
consequence of changing the I/O standard in the I/O worksheet.

Note: In most cases, field dependencies are limited to the same worksheet, and often even
within the same row. However, device, device grade, package and transceiver grade
selection can have a much wider impact, as illustrated above. A simple way to verify
that no unintended changes resulted from changing a device is to use the Export CSV
function to export the EPE state before and after the change in device selection. You
can then compare the two CSV files using a third-party diff utility to identify any fields
that have changed.

3.6. Intel Stratix 10 EPE Buttons

The Early Power Estimator for Intel Stratix 10 devices provides buttons for resetting
the EPE, for importing or exporting a comma-separated value (.csv) file, and for
navigating between worksheets.
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4. Early Power Estimator Worksheets for Intel Stratix 10
Devices

The Early Power Estimator (EPE) for Intel Stratix 10 devices is an Excel*-based
spreadsheet that allows you to enter information into worksheets based on
architectural features. The EPE then reports, in watts, subtotals of the power
consumed by each architectural feature.

For more information about each architectural feature refer to the respective
worksheets.

4.1. Intel Stratix 10 EPE - Common Worksheet Elements

The Early Power Estimator (EPE) for Intel Stratix 10 devices is divided into multiple
worksheets, each allowing entry of a subset of FPGA resources. Some elements are
common to more than one worksheet.

Total Thermal Power

The Total Thermal Power field estimates the total thermal power consumed by all
FPGA resources in the specific worksheet. Some worksheets may also provide a
breakdown of the components contributing to the total thermal power. The total
thermal power displayed in individual worksheets does not include static power, which
is reported on the Main and Report worksheets for the whole device.

Resource Utilization

Most worksheets contain one or more fields that provide an estimate of the
percentage resource utilization for the modules in the specific worksheet. Such values
are calculated based on the maximum available resources of a given type for a
selected device. If resource utilization exceeds 100%, the value is highlighted in red to
alert you that the current device may not be able to support the resources entered
into the worksheet. Additionally, the thermal power value displayed in the Main and
Report worksheets is displayed in red for any worksheet whose utilization exceeds
100%.

Power Rail Current Consumption

Most worksheets include a table showing the dynamic current consumption (and
standby current consumption, if applicable) for all power rails used by the FPGA
resources in the specific worksheet. The same power rail may appear in multiple
worksheets, and the dynamic and standby currents reported in the Report worksheet
are the sums of all corresponding currents for a given rail at a given voltage in
individual worksheets. The Report worksheet also includes static currents, which are
not reported in individual worksheets.
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Why Typical Power Might Appear Larger than Maximum Power

Due to the methodologies employed by power modeling, instances can occur where
the typical power for an Intel Stratix 10 device may appear to be higher than the
maximum power. Every Intel Stratix 10 device is tested during the manufacturing
process; this testing includes measuring the maximum static current drawn by each
device rail, and total static power consumed across all rails. A given device does not
draw maximum current on each rail simultaneously — consequently, the total static
power actually consumed by the device in operation, is going to be lower than the
sum of the individual maximum static powers measured for each rail.

The Report worksheet (and the Intel Quartus Prime Power Analyzer per-rail report)
indicate the maximum per-rail static currents based on actual measurements, to help
you choose appropriate voltage regulators. However, when calculating total thermal
power and total static power, we make more realistic — and generally lower —
assumptions for total static power across all rails.

Maximum power values are helpful for determining the proper regulator size for power
delivery, and the proper thermal solution for cooling, to ensure operation to published
specifications.

Typical power values are helpful for estimating average battery life or total cost of
ownership. Typical values account for variations in process and are not based on real
measurements of individual devices — they are not guaranteed values.

Instances can arise where the typical power reported may be larger than the
maximum power. This aberration is a consequence of the modeling methods used, and
is not indicative of an error.

Errors and Warnings

Error and warning fields display error and warning messages alerting you to problems
with the information entered into this or another related worksheet. If there are error
messages in a worksheet, the thermal power value displayed in the Main and Report
worksheets corresponding to this worksheet is highlighted in red to indicate an error
message. For accurate power estimates, you should resolve all error messages.

4.2. Intel Stratix 10 EPE - Main Worksheet

The Main worksheet of the Early Power Estimator (EPE) for Intel Stratix 10 devices
allows you to enter device, package, and cooling information, and displays thermal
power and thermal analysis information.
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Figure 7. Intel Stratix 10 EPE Main Worksheet

The required parameters depend on whether the junction temperature is manually
entered or auto computed.

Table 3. Input Parameter Information

Parameter Description

Family Select the device family.

Device Select your device.
Larger devices consume more static power and have higher clock dynamic
power. All other power components are unaffected by device selection.

Device Grade Select the combination of Operating Temperature, Speed Grade, and Power
Option used.
• Operating Temperature: Extended (TJ = 0C to 100C), Industrial (TJ =

-40C to 100C)
• FPGA Core Fabric Speed Grade: 1 (fastest), 2 or 3.
• Power Option: X (Extreme Low), L (Low), or V (SmartVID)

Package Select the device package.
Larger packages provide a larger cooling surface and more contact points to
the circuit board, thus they offer lower thermal resistance. Package
selection does not affect dynamic power directly.

Transceiver Grade Select the transceiver grade.

continued...   
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Parameter Description

Note: For information on transceiver grades, refer to Intel Stratix 10
Device Variants and Packages, in the Intel Stratix 10 Device
Overview.

Power Characteristics Select typical or theoretical worst-case silicon process.
There is a process variation from die-to-die. This variation primarily affects
static power consumption.
If you choose Typical power characteristics, estimates are based on long-
term projections of average power consumed by typical silicon. For FPGA
board power supply design and thermal design, choose Maximum for
worst-case values.

VCC Voltage (mV) Select the voltage of the VCC power rail, in mV.

Power Model Status Indicates whether the power model for the device is in preliminary,
advance, or final status.

Thermal power is the power dissipated in the device. Total thermal power is the sum
of the thermal power of all the resources used in the device, including the static,
standby, and dynamic power. Total thermal power includes only the thermal
component for the I/O worksheet and does not include external power dissipation,
such as from voltage-referenced termination resistors.

The static power (PSTATIC) is the thermal power dissipated on the chip, independent of
design activity. PSTATIC includes the static power from all FPGA functional blocks,
except for I/O DC bias power and transceiver DC bias power, which are included in the
standby power of the I/O and XCVR worksheets, respectively. PSTATIC is the only
thermal power component that varies with junction temperature and power
characteristics (process). PSTATIC is also the only thermal power component that varies
significantly with selected device.

Table 4. Thermal Power (W) Information

Column Heading Description

Logic Displays the dynamic power consumed by adaptive logic
modules (ALMs), flipflops (FFs) and associated routing. Click
Logic to see details.

RAM Displays the dynamic power consumed by RAMs and
associated routing. Click RAM to see details.

DSP Displays the dynamic power consumed by digital signal
processing (DSP) blocks and associated routing. Click DSP
to see details.

Clock Displays the dynamic power consumed by clock networks.
The clock dynamic power is affected by the selected device.
Click Clock to see details.

PLL Displays the dynamic power consumed by phase-locked
loops (PLLs). Click PLL to see details.

I/O Displays the thermal power consumed by I/O pins and I/O
subsystems. Click I/O to see details.

XCVR Displays the total power consumed by transceiver blocks.
Click XCVR to see details.

HPS Displays the total power consumed by the HPS system.

HBM Total power consumed by high-bandwidth memory (HBM)
blocks and UIBs. Click the HBM button to display details.

continued...   
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Column Heading Description

PSTATIC Displays the static power consumed regardless of clock
frequency. This includes static power consumed by I/O and
transceiver blocks, but does not include standby power.
PSTATIC is affected by junction temperature, selected device,
and power characteristics.
Note: For information on measuring the static power

consumption of a specific device, refer to the
appendix Measuring Static Power.

Total Power Before SmartVID Savings The total power consumption before SmartVID power
savings. Includes static power (PSTATIC) and power
consumed by different blocks as reported above. Does not
include power dissipated in off-chip termination resistors.

SmartVID Power Savings Displays the total power reduction (static and dynamic)
resulting from the lower voltage that is made possible by
SmartVID. This power reduction is dependent on the user
design and device characteristics. The combination of these
factors may result in different static and dynamic power
savings, so the exact dynamic and static components are
not identified separately, and the power reduction reported
here is a worst-case result.
The reduction reported in this field is already taken into
consideration in the Total (W) field.
The SmartVID Power Savings field applies only to devices
that support SmartVID and only when Power
Characteristics is set to Maximum.

TOTAL (W) Total power dissipated as heat from the FPGA. Does not
include power dissipated in off-chip termination resistors.
Total power dissipation in the FPGA may differ from the sum
of power on all rails due to several factors including, but not
limited to, power dissipated in off-chip termination resistors.

Note: If any thermal power value is highlighted in red, it indicates an error in the design
specification. Review the relevant worksheet for errors or utilization values exceeding
100%. Correct any errors to obtain reliable power and temperature estimates.

The Thermal Analysis Summary section displays the junction temperature (TJ) and
other thermal parameters, depending on the thermal analysis mode.

Table 5. Thermal Analysis Summary

Column Heading Description

Junction Temp Mode Select whether you provide the junction temperature, or
whether detailed thermal analysis should be performed to
determine junction temperature. In user-entered mode, the
junction temperatures for all dies in the package are
assumed to have one value, which you provide. When using
a detailed thermal model, temperatures of different dies
may be different, depending on the characteristics of a
specific design. You can select detailed thermal mode only if
the Power Characteristics field is set to Maximum, and
the selected device supports a detailed thermal model.
Tip: For faster responsiveness from the system, you should

leave this value as User Entered until you are ready
to perform detailed thermal analysis.

User-Entered Junction Temp, TJ (°C) Specify the junction temperature for all dies in the package.
Note: This field is applicable only when the selected

Junction Temp Mode value is User Entered.
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Column Heading Description

Ambient Temp, TA (°C) Specifies the temperature of the air that is cooling the
device.
Note: This field is applicable only when the selected

Junction Temp Mode value is Detailed Thermal
Model.

Max. Junction Temp TJ-MAX (°C) Specifies the maximum junction temperature that no part of
any die in the package should exceed.
Note: This field is applicable only when the selected

Junction Temp Mode value is Detailed Thermal
Model.

Recommended ψCA(°C/W) ψCA is the thermal resistance between the center of the
package integrated heat spreader (IHS) and ambient
temperature. The recommended ΨCA is the highest possible
thermal resistance of the cooling solution that ensures no
part of any die exceeds the specified maximum junction
temperature.
Note: This field is applicable only when the selected

Junction Temp Mode value is Detailed Thermal
Model.

Max. ψJC(°C/W) ψJC is the thermal resistance between each of the dies in
the package and the center of the package integrated heat
spreader. This field shows the maximum ΨJC among all die,
assuming the recommended ΨCA value above.
Note: This field is applicable only when the selected

Junction Temp Mode value is Detailed Thermal
Model.

Case Temperature TCASE (°C) The case temperature, which is the temperature at the top
center of the integrated heat spreader, assuming the
recommended ΨCA value listed above.
Note: This field is applicable only when the selected

Junction Temp Mode value is Detailed Thermal
Model.

Note: 

You can directly enter or automatically compute junction temperatures based on the
information provided. To enter the junction temperature, select User Entered in the
Junction Temp Mode field, then enter the desired junction temperature in the User-
Entered Junction Temp TJ (°C) field in the Thermal Analysis Summary section.
In this mode, the junction temperatures for all dies in the package are assumed to
have the specified value. To automatically compute junction temperatures, select
Detailed Thermal Model in the same field. Refer to the Thermal worksheet for
more information about detailed thermal modeling.

Table 6. Control Button Descriptions

Button Name Description

Logic Opens the Logic worksheet to display details of the dynamic
power consumed by adaptive logic modules (ALMs),
flipflops, and associated routing.

RAM Opens the RAM worksheet to display details of the dynamic
power consumed by RAMs and associated routing.
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Button Name Description

DSP Opens the DSP worksheet to display details of the dynamic
power consumed by digital signal processing blocks and
associated routing.

Clock Opens the Clock worksheet to display details of the dynamic
power consumed by clock networks and associated routing.

PLL Opens the PLL worksheet to display details of the dynamic
power consumed by phase-locked loops and associated
routing.

I/O Opens the I/O worksheet to display details of the thermal
power consumed by I/O pins and I/O subsystems.

XCVR Opens the XCVR worksheet to display details of the total
power consumed by transceiver blocks.

HPS Opens the HPS worksheet to display details of the total
power consumed by the HPS system.

HBM Opens the HBM worksheet to display details of the total
power consumed by high-bandwidth memory blocks and
UIBs.

Reset Resets the Early Power Estimator to default values; any
parameters that you have specified are lost.

Import CSV Allows you to import parameters from a comma-separated
value file.

Export CSV Allows you to export parameters to a comma-separated
value file.

View Report Displays the Report worksheet.

Thermal Analysis Details Displays the detailed thermal analysis, on the Thermal
worksheet.

Related Information

• Measuring Static Power on page 57

• Intel Stratix 10 EPE - Thermal Worksheet on page 44

4.3. Intel Stratix 10 EPE - Logic Worksheet

The Logic worksheet of the Early Power Estimator (EPE) for Intel Stratix 10 devices
allows you to enter logic resources for all modules in your design.
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Figure 8. Logic Worksheet of the Early Power Estimator

Table 7. Logic Worksheet Information

Input Parameter Description

Module Specify a name for each module of the design. This is an
optional entry.

#Half ALMs Enter twice the number of Adaptive Logic Modules (ALMs)
used in your design, which you can find in the Compilation
Report, by selecting Fitter ➤ Place Stage ➤ Resource
Usage Summary. For power estimation purposes, the
number of ALMs used in your design is the sum of the
following values in the Compilation Report:
• ALMs used for LUT logic and register circuitry
• ALMs used for LUT logic
• ALMs used for register circuitry
• ALMs adjustment for power estimation
The adjustment for power estimation is necessary because
some unused ALMs may still consume power due to Fitter
optimizations.

# FFs Enter the number of Primary logic registers, plus
Secondary logic registers, plus the number of registers
reported as Register control circuitry for power
estimation, all of which you can find in the Compilation
Report, by selecting Fitter ➤ Place Stage ➤ Resource
Usage Summary. This adjustment is necessary because
some unused registers may still consume power due to
fitter optimizations.
Clock routing power associated with flipflops is calculated
separately on the Clock worksheet of the EPE spreadsheet.

Clock Freq (MHz) Enter a clock frequency (in MHz). This value is limited by
the maximum frequency specification for the device family.

continued...   
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Input Parameter Description

Note: When you import a design from the Intel Quartus
Prime software, some imported half ALMs and
flipflops may have a clock frequency of 0 MHz; this
can occur for one of two reasons:
• The Intel Quartus Prime software did not have

sufficient information to determine clock
frequency due to incomplete clock constraints.

• The Intel Quartus Prime software exported a
comma-separated value (.csv) file containing
half ALMs where only flipflops are used. Such
ALMs are imported as ALMs with clock frequency
of 0 MHz, while their flipflops are imported into a
separate row with the correct clock frequency.

Toggle % Enter the average percentage of clock cycles when the block
output signals change values. Toggle percentage is
multiplied by clock frequency to determine the number of
transitions per second. For example, 100 MHz frequency
with a 12.5% toggle rate, means that each LUT or flipflop
output toggles 12.5 million times per second (100MHz ×
12.5%).
The toggle percentage ranges from 0 to 100%. Typically,
the toggle percentage is 12.5%, which is the toggle
percentage of a 16-bit counter. Most logic only toggles
infrequently; therefore, toggle rates of less than 50% are
more realistic. To ensure you do not underestimate the
toggle percentage, use a realistic toggle percentage
obtained through simulation.
For example, a T flipflop (TFF) with its input tied to VCC has
a toggle rate of 100% because its output is changing logic
state on every clock cycle. Refer to the 4-Bit Counter
Example below for a more detailed analysis.
For any rows containing flip-flops, toggle percentage cannot
exceed 100%. A small portion of ALMs in a design may
experience glitching that results in toggle percentage
exceeding 100% for such ALMs. Enter such ALMs into a
separate row with # FFs set to 0.

Routing Factor Indicates the extent of the routing power of the outputs.
Characteristics that have a large power impact and are
captured by this factor include the following:
• The fanout of the outputs
• The number of routing resources used
• The relative power usage of the different types of

routing resources used
The default value for this field is typical; the actual value
varies between blocks in your design, and depends on the
placement of your design. For most accurate results, you
should import this value from the Intel Quartus Prime
software after compiling your design, because the Intel
Quartus Prime software has access to detailed placement
and routing information.
In the absence of an Intel Quartus Prime design, higher
values generally correspond to signals that span large
distances on the FPGA and fanout to many destinations,
while lower values correspond to more localized signals.
You can change this field from its default value to explore
possible variations in power consumption depending on
block placement. When changing this value, keep in mind
that typical designs rarely use extreme values, and only for
a small subset of the design.

Thermal Power (W) - Routing Indicates the power dissipation due to estimated routing (in
W).
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Input Parameter Description

Routing power depends on placement and routing, which is
a function of design complexity. The values shown are
representative of routing power based on observed behavior
across more than 100 real-world designs.
Use the Intel Quartus Prime Power Analyzer for accurate
analysis based on the exact routing used in your design.

Thermal Power (W) - Block Indicates the power dissipation due to internal toggling of
the ALMs (in W).
Logic block power is a combination of the function
implemented and the relative toggle rates of the various
inputs. The EPE spreadsheet uses an estimate based on
observed behavior across more than 100 real-world
designs.
Use the Intel Quartus Prime Power Analyzer for accurate
analysis based on the exact synthesis of your design.

Thermal Power (W) - Total Indicates the estimated power (in W), based on information
entered into the EPE spreadsheet. It is equal to the sum of
routing power and block power.

User Comments Enter any comments. This is an optional entry.

Figure 9. 4-Bit Counter Example
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The cout0 output of the first TFF has a toggle percentage of 100% because the signal
toggles on every clock cycle. The toggle percentage for the cout1 output of the
second TFF is 50% because the output toggles every two clock cycles. Similarly, the
toggle percentage for the cout2 and cout3 outputs are 25% and 12.5%,
respectively. Therefore, the average toggle percentage for this 4-bit counter is (100 +
50 + 25 + 12.5)/4 = 46.875%.

For more information about logic block configurations, refer to the Intel Stratix 10
Logic Array Blocks and Adaptive Logic Modules User Guide.

4.4. Intel Stratix 10 EPE - RAM Worksheet

Each row in the RAM worksheet of the Early Power Estimator (EPE) for Intel Stratix 10
devices represents a design module with RAM blocks of the same type, same data
width, same RAM depth (if applicable), same RAM mode, and the same port
parameters.
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Each row in the RAM worksheet of the EPE spreadsheet represents a logical RAM
module that you can implement using one or more physical RAM blocks. The EPE
spreadsheet implements each logical RAM module with the minimum number of
physical RAM blocks, in the most power-efficient way possible, based on the specified
logical width and depth.

You must know how your RAM is implemented by the Intel Quartus Prime Compiler
when you are selecting the RAM block mode. For example, if a ROM is implemented
with two ports, it is considered a true dual-port memory and not a ROM. Single-port
and ROM implementations use only one port. Simple dual-port and true dual-port
implementations use both Port A and Port B.

Note: 
• The Early Power Estimator reports MLAB power in the RAM worksheet. However

the Intel Quartus Prime Power Analyzer reports MLAB power as Combinational cell
and Register cell block type in the Thermal Power Dissipation by Block Type
section of the power report.

• The Intel Quartus Prime Power Analyzer reports LAB clock power as Block Thermal
Dynamic Power under Clock Network block type in the Thermal Power Dissipation
by Block Type section of the power report. The Early Power Estimator reports LAB
clock power in either the Clock or RAM worksheet, depending on whether the LAB
is used to implement logic or used as MLAB, respectively.

Figure 10. RAM Worksheet of the Early Power Estimator

Table 8. RAM Worksheet Information

Column Heading Description

Module Enter a name for the RAM module in this row. This is an
optional value.

RAM Type Select the implemented RAM type.
You can find the RAM type in the Type column of the Intel
Quartus Prime Compilation Report. In the Compilation
Report, select Fitter ➤ Place Stage ➤ Fitter RAM
Summary.
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Column Heading Description

# RAM Blocks Enter the number of RAM blocks in the module that use the
same type and mode and have the same parameter for
each port. The parameters for each port are as follows:
• Clock frequency in MHz
• Percentage of time the RAM is enabled
• Percentage of time the port is writing as opposed to

reading
You can find the number of RAM blocks in either the MLAB
cells or M20K blocks column of the Intel Quartus Prime
Compilation Report. In the Compilation Report, select Fitter
➤ Place Stage ➤ Fitter RAM Summary.
Note: The value entered into this field represents the

number of logical memory blocks. Depending on the
specified memory depth and data width, more than
one physical memory block may be required to
implement one logical block. The Early Power
Estimator calculates the number of physical memory
blocks based on the specified memory depth and
data width, such that the minimum number of
physical blocks is used, and assuming the most
power efficient physical configuration.

Data Width Enter the width of the data for the RAM block. This value is
limited based on the RAM type. You can find the width of
the RAM block in the Port A Width or the Port B Width
column of the Intel Quartus Prime Compilation Report. In
the Compilation Report, select Fitter ➤ Place Stage ➤
Fitter RAM Summary.
For RAM blocks that have different widths for Port A and
Port B, use the larger of the two widths.

RAM Depth Enter the depth of the RAM block in number of words.
You can find the depth of the RAM block in the Port A Depth
or the Port B Depth column of the Intel Quartus Prime
Compilation Report. In the Compilation Report, select Fitter
➤ Place Stage ➤ Fitter RAM Summary.

RAM Mode Select from the following modes:
• Single Port
• Simple Dual Port
• True Dual Port
• Simple Dual Port with ECC
• ROM
• Simple Quad Port
The mode is based on how the Intel Quartus Prime Compiler
implements the RAM. If you are unsure how your memory
module is implemented, you can compile a test case in the
required configuration in the Intel Quartus Prime software.
You can find the RAM mode in the Mode column of the Intel
Quartus Prime Compilation Report. In the Compilation
Report, select Fitter ➤ Place Stage ➤ Fitter RAM
Summary.
A single-port RAM has one port with a read and a write
control signal. A simple dual-port RAM has one read port
and one write port. A true dual-port RAM has two ports,
each with a read and a write control signal. ROMs are read-
only single-port RAMs. A simple quad-port RAM has a total
of four ports, two read ports and two write ports.

Port A - Clock Freq (MHz) Enter the clock frequency for Port A of the RAM blocks (in
MHz). This value is limited by the maximum frequency
specification for the RAM type and device family.
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Column Heading Description

Port A - Enable % The average percentage of time the Port A clock enable is
active, regardless of activity on RAM data and address
inputs. This number must be a percentage between 0% and
100%. RAM power is consumed primarily when a clock
event occurs. Using a clock enable signal to disable a port
when no read or write operation is occurring can result in
significant power savings.

Port A - Read % Enter the percentage of time Port A of the RAM block is in
read mode. This field is applicable only for single port and
true dual port RAMs.
This value must be a percentage number between 0 and
100%.

Port A - Write % Enter the average percentage of time Port A of the RAM
block is in write mode. This field applies only for single port,
dual port and true dual port RAMs.
This value must be a percentage number between 0 and
100%.

Port B - Clock Freq (MHz) Enter the clock frequency for Port B of the RAM blocks (in
MHz).

Port B - Enable % Enter the average percentage of time the input clock enable
for Port B is active, regardless of the activity on the RAM
data and address inputs. The enable percentage ranges
from 0 to 100%.
RAM power is consumed primarily when a clock event
occurs. Using a clock-enable signal to disable a port when
no read or write operation is occurring can result in
significant power savings.

Port B - Read % Enter the percentage of time Port B of the RAM block is in
read mode. This field is applicable only to dual port and true
dual port RAMs and ROMs.
This value must be a percentage number between 0 and
100%.

Port B - Write % Enter the percentage of time Port B of the RAM block is in
write mode. This field is available only for true dual-port
mode.
This value must be a percentage number between 0 and
100%.

Port C - Write % Enter the percentage of time the RAM block is writing to this
port. In Simple Quad-Port Mode, clock and clock enable for
all parts are shared and the same as Port A.
This value must be a percentage number between 0 and
100%.

Port D - Read % Enter the percentage of time the RAM block is reading on
this port. In Simple Quad-Port Mode, clock and clock enable
for all parts are shared and the same as Port A.
This value must be a percentage number between 0 and
100%.

Toggle % The percentage of clock cycles when the block output signal
changes value. This value is multiplied by the clock
frequency and the enable percentage to determine the
number of transitions per second. This value affects only
routing power.
50% corresponds to a randomly changing signal, since half
the time the signal holds the same value and thus not
transition. This is considered the highest meaningful toggle
rate for a RAM block.
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Column Heading Description

Thermal Power (W) - Routing Indicates the power dissipation due to estimated routing (in
W).
Routing power depends on placement and routing, which is
a function of design complexity. The values shown represent
the routing power estimate based on observed behavior
across more than 100 real-world designs.
Use the Intel Quartus Prime Power Analyzer for accurate
analysis based on the exact routing used in your design.

Thermal Power (W) - Block Indicates the power dissipation due to internal toggling of
the RAM (in W).
Use the Intel Quartus Prime Power Analyzer for accurate
analysis based on the exact RAM modes in your design.

Thermal Power (W) - Total Indicates the estimated power (in W), based on information
entered into the EPE spreadsheet. Total power is equal to
the sum of routing power and block power.

User Comments Enter any comments. This is an optional entry.

4.5. Intel Stratix 10 EPE - DSP Worksheet

Each row in the DSP worksheet of the Early Power Estimator for Intel Stratix 10
devices represents a DSP design module where all instances have the same
configuration, clock frequency, toggle percentage, and register usage.

Figure 11. DSP Worksheet of the Early Power Estimator

Table 9. DSP Worksheet Information

Column Heading Description

Module Enter a name for the DSP module in this column. This is an
optional value.

Configuration Select the DSP block configuration for the module.

# of Instances Enter the number of DSP block instances that have the
same configuration, clock frequency, toggle percentage, and
register usage. This value is not necessarily equal to the
number of dedicated DSP blocks you use. For example, it is
possible to use two 18 × 18 simple multipliers that are
implemented in the same DSP block in the FPGA devices. In
this case, the number of instances would be two.
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Column Heading Description

To determine the maximum number of instances you can fit
in the device for any particular mode, follow these steps:
1. Open the “Variable Precision DSP Blocks” chapter of the

Intel Stratix 10 Device Handbook.
2. In the “Number of DSP Blocks” table, take the maximum

number of DSP blocks available in the device for the
mode of operation.

3. Divide the maximum number by the “# of Mults” for that
mode of operation from the “DSP Block Operation
Modes” table. The resulting value is the maximum
number of instances supported by the device.

Clock Freq (MHz) Enter the clock frequency for the module (in MHz). This
value is limited by the maximum frequency specification for
the device family.

Toggle % Enter the average percentage of DSP data outputs toggling
on each clock cycle. The toggle percentage ranges from 0 to
50%. The default value is 12.5%. For a more conservative
power estimate, use a higher toggle percentage.
50% corresponds to a randomly changing signal, since half
the time the signal holds the same value and thus not
transition. This is considered the highest meaningful toggle
rate for a DSP block.

Preadder? Select Yes if the PreAdder function of the DSP block is
turned on.

Coefficient? Select Yes if the Coefficient function of the DSP block is
turned on.

Registered Stages Select number of the registered stages. Having more stages
registered increases DSP fMAX and reduces power
consumption at the cost of increased latency.
• 0—None
• 1—Input
• 2—Input and Output
• 3—Input, Output, and Multiplier
• 4— Input, Output, Multiplier, and Pipeline Stage 2
• 5—Input, Output, Multiplier, Pipeline Stage 2, and

Floating-Point Adder

Thermal Power (W)–Routing Indicates the power dissipation due to estimated routing (in
W).
Routing power depends on placement and routing, which is
a function of design complexity. The values shown represent
the routing power estimate based on observed behavior
across more than 100 real-world designs.

Thermal Power (W)–Block Indicates the estimated power consumed by the DSP blocks
(in W).

Thermal Power (W)–Total Indicates the estimated power (in W), based on information
entered into the EPE spreadsheet. It is the total power
consumed by the DSP blocks and is equal to the routing
power and block power.

User Comments Enter any comments. This is an optional entry.
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4.6. Intel Stratix 10 EPE - Clock Worksheet

Each row in the Clock worksheet of the Early Power Estimator (EPE) for Intel Stratix
10 devices represents a clock network or a separate clock domain.

Intel Stratix 10 devices support global, regional, and periphery clock networks. The
EPE spreadsheet does not distinguish between global or regional clocks because the
difference in power is not significant.

Figure 12. Clock Worksheet of the Early Power Estimator

Table 10. Clock Worksheet Information

Column Heading Description

Domain Specify a name for the clock domain in this row. This is an
optional value.

Clock Freq (MHz) Enter the frequency of the clock domain. This value is
limited by the maximum frequency specification for the
device family.
Note: When you import a design from the Intel Quartus

Prime software, some imported clocks may have a
frequency of 0 MHz, due to either of the following
reasons:
• The Intel Quartus Prime software did not have

sufficient information to determine clock
frequency due to incomplete clock constraints.

• Clock resources were used to route a reset
signal, which toggles infrequently, so its
frequency is reported as 0 MHz.

Total Fanout Enter the total number of flipflops, hyper-registers, RAMs,
digital signal processing (DSP) blocks, and I/O pins fed by
this clock.
Power consumed by MLAB clocks is accounted for in the
RAM worksheet; therefore, clock fanout on this worksheet
does not include any MLABs driven by this clock domain.
The number of resources driven by every global clock and
regional clock signal is reported in the Fan-out column of
the Intel Quartus Prime Compilation Report. In the
Compilation Report, select Fitter and click Place Stage.
Select Global & Other Fast Signals Summary and
observe the Fan-out value.
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Column Heading Description

Global Enable % Enter the average percentage of time that the entire clock
tree is enabled. Each global clock buffer has an enable
signal that you can use to dynamically shut down the entire
clock tree.

Local Enable % Enter the average percentage of time that clock enable is
high for destination flipflops.
Local clock enables for flipflops in ALMs are promoted to
LAB-wide signals. When a given flipflop is disabled, the LAB-
wide clock is disabled, cutting clock power and the power
for down-stream logic. This worksheet models only the
impact on clock tree power.

Utilization Factor Represents the impact of the clock network configuration on
power.
Characteristics that have a large impact on power and are
captured by this factor include the following:
• Whether the network is widely spread out
• Whether the fanout is small or large
• The clock settings within each LAB
The default value for this field is typical; the actual value
varies between clocks in your design, and depends on the
placement of your design. For most accurate results, you
should import this value from the Intel Quartus Prime
software after compiling your design, because the Intel
Quartus Prime software has access to detailed placement
information.
In the absence of an Intel Quartus Prime design, higher
values generally correspond to signals that span large
distances on the FPGA and fanout to many destinations,
while lower values correspond to more localized signals.
You can change this field from its default value to explore
possible variations in power consumption depending on
block placement. When changing this value, keep in mind
that typical designs rarely use extreme values, and only for
a small subset of the design.

Total Power (W) Indicates the total power dissipation due to clock
distribution (in W).

User Comments Enter any comments. This is an optional entry.

Note: The Intel Quartus Prime Power Analyzer reports LAB clock power as Block Thermal
Dynamic Power under Clock Network block type in the Thermal Power Dissipation by
Block Type section of the power report. The Early Power Estimator reports LAB clock
power in either the Clock or RAM worksheet, depending on whether the LAB is used to
implement logic or used as MLAB, respectively.

For more information about the clock networks of Intel Stratix 10 devices, refer to the 
Intel Stratix 10 Clocking and PLL User Guide.

4.7. Intel Stratix 10 EPE - PLL Worksheet

Each row in the PLL worksheet of the Early Power Estimator (EPE) for Intel Stratix 10
devices represents one or more PLLs in the device.

For Intel Stratix 10 devices, the supported PLL types are IOPLL, fPLL, ATX PLL, and
CMU PLL.
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Figure 13. PLL Worksheet of the Early Power Estimator

Table 11. PLL Worksheet Information

Column Heading Description

Module Specify a name for the PLL in this column. This is an
optional value.

PLL Type Specifies the type of PLL. Intel Stratix 10 devices have I/O
PLLs, fPLLs, CMU PLLs, and ATX PLLs. CMU PLLs and ATX
PLLs are for L-tile and H-tile transceiver use exclusively. (E-
tile transmitter PLLs are included in the XCVR worksheet
and are not included in the PLL worksheet.)

# PLL Blocks Enter the number of PLL blocks with the same combination
of parameters.

XCVR Die ID Specify the transceiver die on which PLLs on this row are
located. This field is not applicable for I/O PLLs.

# Counters Enter the number of counters of the PLL. For fPLL, this
includes C counter, L counter, and feedback. This field is not
applicable for ATX PLLs and CMU PLLs.

VCCR_GXB and VCCT_GXB Voltage Specify the voltage of the VCCR_GXB and VCCT_GXB rails. This
field is not applicable for I/O PLLs.

Output Freq (MHz) Specify the output frequency for CMU and ATX PLLs.

VCO Freq (MHz) Specify the internal VCO operating frequency for fPLLs and
I/O PLLs. When using an fPLL as a transmitter PLL for XCVR
channels, the VCO frequency has to be such that the
required fPLL output frequency can be achieved using a
legal value of the counter used for HSSI clock output.
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Column Heading Description

You can find the VCO frequency (in Hz) in the Intel Quartus
Prime Compilation Report. In the Compilation Report, select
Fitter ➤ Plan Stage ➤ HSSI Transmitter PLL ➤
vco_freq for each fPLL instance.

Total Power (W) Shows the total estimated power for this row (in W).

User Comments Enter any comments. This is an optional entry.

For more information about the PLLs available in Intel Stratix 10 devices, refer to the 
Intel Stratix 10 Clocking and PLL User Guide.

4.8. Intel Stratix 10 EPE - I/O Worksheet

Each row in the I/O worksheet of the Early Power Estimator (EPE) for Intel Stratix 10
devices represents a design module where the I/O pins have the same I/O standard,
input termination, current strength or output termination, data rate, clock frequency,
output enable static probability, and capacitive load.

Figure 14. I/O Worksheet of the Early Power Estimator

When using the EPE spreadsheet, it is assumed you are using external termination
resistors as recommended for SSTL and high-speed transceiver logic HSTL. If your
design does not use external termination resistors, choose the LVTTL/ LVCMOS I/O
standard with the same VCCIO and similar current strength as the terminated I/O
standard. For example, if you are using the SSTL-2 Class II I/O standard with a 16 mA
current strength, you must select 2.5 V as the I/O standard and 16 mA as the current
strength in the EPE spreadsheet.

To use on-chip termination (OCT), select the Current Strength/Output
Termination option in the EPE spreadsheet.

The power reported for the I/O signals includes thermal and external I/O power. The
total thermal power is the sum of the thermal power consumed by the device from
each power rail, as shown in the following equation.
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Figure 15. Total Thermal Power

thermal power = thermal PVCCP + thermal PVCCPT + thermal PVCCIO(_HPS/3V)

The following figure shows the I/O power consumption. The ICCIO power rail includes
both the thermal PIO and the external PIO.

Figure 16. I/O Power Representation

The VREF pins consume minimal current (typically less than 10 μA), which is negligible
when compared with the current consumed by the general purpose I/O (GPIO) pins;
therefore, the EPE spreadsheet does not include the current for VREF pins in the
calculations.

Table 12. I/O Worksheet Information

Column Heading Description

Module Specify a name for the I/O in this column. This is an
optional value.

Application Specify the application for this I/O row. GPIO and SerDes
interfaces can be instantiated using this field. Use the I/O-
IP worksheet to instantiate external memory interface
(EMIF) interfaces.

Bank Type Specifies the type of I/O bank for this row.
• 1P8V banks support I/O standards up to 1.8V as well as

LVDS I/O standards.
• 3VIO banks support CMOS I/O standards up to 3.0V.
• HPS banks include dedicated HPS pins.
• HPS-1P8V banks are similar to 1P8V banks in terms of

supported I/O standards; these banks can serve as
either general purpose I/Os or as EMIF interfaces in HPS
applications.

DDR Rate Specifies the clock rate of PHY logic. Determines the clock
frequency of PHY logic in relation to the memory clock
frequency.
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Column Heading Description

For example, if the memory clock sent from the FPGA to the
memory device is toggling at 800MHz, a quarter rate
interface means that the PHY logic in the FPGA runs at
200MHz.

I/O Buffer Settings - I/O Standard Specifies the I/O standard used by the I/O pins in this
module.

I/O Buffer Settings - Input Termination Specifies the input termination setting for the input and
bidirectional pins in this module.

I/O Buffer Settings - Current Strength/Output Termination Specifies the current strength or output termination setting
for the output and bidirectional pins in this module. Current
strength and output termination are mutually exclusive.

I/O Buffer Settings - Slew Rate Specifies the slew rate setting for the output and
bidirectional pins in this module. Using a lower slew rate
setting helps reduce switching noise but may increase delay.

I/O Buffer Settings - VOD Setting Specifies the differential output voltage (VOD) for the output
and bidirectional pins in the module. A smaller number
indicates a smaller VOD which reduces static power.

I/O Buffer Settings - Pre-Emphasis Setting Specifies the pre-emphasis setting for the output and
bidirectional pins in this module. A smaller number indicates
a smaller pre-emphasis which reduces dynamic power.

I/O Buffer Settings - # Input Pins Specifies the number of input-only I/O pins in this module.
Differential pin pairs count as one pin.

I/O Buffer Settings - # Output Pins Specifies the number of output-only I/O pins in this module.
Differential pin pairs count as one pin.

I/O Buffer Settings - # Bidir Pins Specifies the number of bidirectional I/O pins in this
module. Differential pin pairs count as one pin.
The I/O pin is treated as an output when its output enable
signal is active and is treated as an input when the output
enable signal is disabled.
An I/O pin configured as a bidirectional pin, but used only
as an output, consumes more power than if it were
configured as an output-only pin, due to the toggling of the
input buffer every time the output buffer toggles (they
share a common pin).

I/O Buffer Settings - Data Rate Indicates whether I/O value changes once (Single-Data
Rate) or twice (Double-Data Rate) per cycle.

I/O Buffer Settings - Registered Pin Indicates whether the pin is registered or not.

I/O Buffer Settings - Toggle % Percentage of clock cycles when the I/O signal changes
value. This value is multiplied by clock frequency to
determine the number of transitions per second. If DDR is
selected, the toggle rate is multiplied by an additional factor
of two.

I/O Buffer Settings - OE % For modules with Input Termination set to OFF, enter the
average percentage of time that:
• Output I/O is enabled
• Bidirectional I/O is an output and enabled
During the remaining time:
• Output I/O is tri-stated
• Bidirectional I/O is an input
Input Termination cannot be active while the Output I/O is
enabled, so for modules with Input Termination not set to
OFF, enter the average percentage of time that On-Chip
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Column Heading Description

Termination is inactive (that is, 1-percentage that the On-
Chip Termination is active).This number must be a
percentage between 0% and 100%.

I/O Buffer Settings - Load (pF) Specifies pin loading external to the chip (in pF). Applies
only to outputs and bidirectional pins. Pin and package
capacitance is already included in the I/O model. Include
only off-chip capacitance.

SerDes-DPA Settings - SerDes-DPA Mode Selects the mode of SerDes-DPA block.

SerDes-DPA Settings - Data Rate (Mbps) The maximum data rate of the SerDes channels in Mbps.

SerDes-DPA Settings - # SerDes Channels The number of channels running at the data rate of this
SerDes domain.

SerDes-DPA Settings - Serialization Factor Number of parallel data bits for each serial data bit.

I/O Subsystem Clocks - Pin Clock/Memory Clock Frequency
(MHz)

Clock frequency (in MHz). 100 MHz with a 12.5% toggle
percentage would mean that each I/O pin toggles 12.5
million times per second (100 MHz * 12.5%).

I/O Subsystem Clocks - Periphery Clock Freq (MHz) The I/O subsystem internal PHY clock frequency. This is an
output-only field.
In SerDes applications, the PHY clock frequency is a
function of the SerDes rate and serialization factor.
In external memory interface (EMIF) applications, the PHY
clock frequency is a function of the memory clock frequency
and DDR rate of the EMIF IP.

I/O Subsystem Clocks - VCO Clock Freq (MHz) The internal VCO operating frequency. This is an output-only
field.
In SerDes applications, VCO frequency is a function of
SerDes Data rate.
In external memory interface (EMIF) applications, the VCO
frequency is a function of the memory clock frequency of
the EMIF IP. The VCO frequency is not applicable in GPIO
mode.

Pin Thermal Power (W) - Digital Power dissipated in the digital domain of the I/O-subsystem
including GPIO, EMIF controller and SerDes controller.

Pin Thermal Power (W) - Analog Power dissipated in the analog domain of the I/O-
subsystem, for example, I/O buffers.

User Comments Enter any comments. This is an optional entry.

For more information about the I/O standard termination schemes, refer to I/O and
High Speed I/Os in Intel Stratix 10 Devices.

4.9. Intel Stratix 10 EPE - I/O-IP Worksheet

Each row in the I/O-IP worksheet of the Early Power Estimator (EPE) for Intel Stratix
10 devices represents a design module.You can use the I/O-IP worksheet to
instantiate external memory interface and HPS IPs supported in Intel Stratix 10
devices. The I/O-IP worksheet populates other EPE worksheets with resources used by
a selected IP.

Analog I/O power and digital power of hard memory controllers and HPS IPs entered
on this tab are reported in the Analog Power and Digital Power fields of the I/O
worksheet. If the IP uses other resource types (for example Logic or PLL), the power
is reported on the corresponding worksheet.
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Figure 17. I/O-IP Worksheet of the Early Power Estimator

I/O-IP Worksheet Information

Column Heading Description

Module Specify a name for the IP in this column. The module name
depends on the selected IP type. It helps to cross-reference
each IP module and its corresponding auto-populated
entries on other worksheets.

IP Specifies the name of the IP in the design.

Voltage Specifies the I/O voltage of the signaling between periphery
device and interface.

Data Width (Bits) Specifies the interface data width of the specific IP (in bits).

Data Group Width Specifies the number of DQ pins per data group.

Memory Device(s) Specifies the number of memory devices connected to the
interface.

Address Width Specifies the address width. This value is used to derive the
total number of address pins required.

DDR Rate Specifies the clock rate of user logic. Determines the clock
frequency of user logic in relation to the memory clock
frequency. For example, if the memory clock sent from the
FPGA to the memory device is toggling at 800MHz, a
"Quarter rate" interface means that the user logic in the
FPGA runs at 200MHz.

PHY Rate Specifies the clock rate of PHY logic. Determines the clock
frequency of PHY logic in relation to the memory clock
frequency. For example, if the memory clock sent from the
FPGA to the memory device is toggling at 800MHz, a
"Quarter rate" interface means that the PHY logic in the
FPGA runs at 200MHz.

Memory Clock Freq (MHz) Specifies the frequency of memory clock (in MHz).

PLL Reference Clock Freq (MHz) Specifies the PLL Reference Clock Frequency (in MHz).

User Comments Enter any comments. This is an optional entry.

4.10. Intel Stratix 10 EPE - XCVR Worksheet

The XCVR worksheet of the Early Power Estimator (EPE) for Intel Stratix 10 devices
allows you to enter XCVR resources and their settings for all modules in your
design.The power of transceiver I/O pins is included in this worksheet. The power of
transmitter PLLs for L-tile and H-tile transceivers is not included in this worksheet, but
is specified in the PLL worksheet instead.
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Figure 18. XCVR Worksheet of the Early Power Estimator

The Early Power Estimator makes the following simplifying assumptions about the
transceiver clock network and the blocks used for L-tile and H-tile transceivers:

• x6 clock lines are used for all channels. Refer to the Intel Stratix 10 L- and H-Tile
Transceiver PHY User Guide for details on the clock line types.

• For each transceiver bank with at least one channel whose transmitter (TX) side is
active, there is exactly one master clock generation block (CGB) used.

Table 13. General Settings in the XCVR Worksheet

Input Parameter Description

Total Thermal Power (W) Total power dissipated in all modules on this page (in Watts). This
power excludes the power the L-tile and H-tile transmitter PLLs,
whose power is provided in the PLL worksheet.

Treatment of Unused HSSI Dies Specify how L-tile and H-tile HSSI dies not actively used by
transceiver channels should be treated when calculating static power.
If none of the transceiver channels or PLLs on an HSSI die are used,
the die can be powered down or remain powered. The voltage of
unused dies that are powered can be selected to minimize static
power, or to minimize the number of power supply voltages required.
For example, if active H-tile transceiver channels use VCCR_GXB=1.12V,
selecting Minimize Leakage assumes that the unused-but-powered
H-tile dies use VCCR_GXB=1.03V, which is the lowest supported voltage,
thus minimizing leakage.
Selecting Minimize Number of Supply Voltages assumes that the
unused-but-powered banks use VCCR_GXB=1.12V, which is the voltage
used by active channels, thus eliminating the need for the 1.03V
power supply on VCCR_GXB.
Early Power Estimator uses information in columns XCVR Die ID,
Starting Channel Location, and # of Channels on the XCVR
worksheet, along with columns # PLL Blocks and XCVR Die ID on
the PLL worksheet to determine whether dies are actively used.
This setting does not apply to E-tile transceivers, because E-tile
transceiver dies can never be powered down.
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Each row in the XCVR worksheet represents a separate transceiver domain. Enter the
following parameters for each transceiver domain:

Table 14. XCVR Worksheet Information

Column Heading Description

Module Specifies a name for the module. This is an optional value.

Tile Specifies the type of transceiver die on which transceiver
channels are located. Some devices may include more than
one type of transceiver die.
This field changes depending on the device options that you
choose on the Main worksheet.

XCVR Die ID Specify the transceiver die on which transceiver channels on
this row are located.

Starting Channel Location Specify the starting location within the bank for the
channels specified in this row. For example, if a given row
contains 3 channels, and starting location is specified to be
12, channels are assumed to be in locations 12, 13, and 14.
Location 0 denotes the bottom-most channel on the
transceiver die.

# of Channels Specifies the number of channels used in this transceiver
domain. Each row represents one transceiver domain. These
channels are grouped together in one transceiver bank, or
two or more adjacent transceiver banks and clocked by one
or more common transmitter PLLs.
For E-tile transceivers, when the channel is configured in
PAM4 mode and the data rate is greater than 28.9 Gbps,
enter two physical channels to represent a single PAM4
logical channel.
Note: For PCI Express protocols with Hard IP, the Hard IP

block supports x1, x2, x4, x8, and x16 modes. The
total number of channels using PCI Express Hard IP
on a single transceiver die must be one of 1, 2, 4, 8,
or 16, because each L-tile or H-tile die supports only
one PCI Express Hard IP.

Operation Mode Specifies whether the hardware is configured in full duplex
transceiver mode (Receiver and Transmitter) or in Receiver
Only or Transmitter Only mode. Allowed values depend on
the selected PCS/HIP mode.

Data Rate (Mbps) Specifies the data rate (in Mbps) for the transceiver. Allowed
values depend on the selected protocol and selected device.
For L-tile and H-tile transceiver dies, allowed values also
depend on the VCCR_GXB and VCCT_GXB voltages.

Digital/Analog Interface Width Specify the width of the parallel data bus between PCS and
PMA.
For E-tile PMA Direct, set to PMA parallel data width, even if
FPGA FIFO widens the interface. As an example, for 25
Gbps PMA Direct you would typically set this value to 32.
When the FEC or EHIP is used, you would set this value to
32 for NRZ mode and 64 for PAM4 mode.

Power Mode E-tile transceivers can operate at either Normal Power Mode
or Low Power Mode.
For the thermal and regulator sizing, you must set the E-tile
transceivers in the Normal Power Mode, because your board
design must take into consideration the maximum power
conditions. Refer to the E-tile Transceiver PHY User Guide
for information on how to switch transceivers from Normal
Power Mode to Low Power Mode.
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Column Heading Description

FEC Specify the Forward Error Correction setting. This field is
applicable only to E-tile transceivers.

EHIP Specify the Ethernet Hard IP protocol. This field is applicable
only to E-tile transceivers.

Modulation Mode Specify the data modulation mode of transceiver channels.
This field is applicable only to E-tile transceivers.

Digital Frequency (MHz) Specify the digital frequency at which the digital portion of
the transceiver (including FEC and EHIP) operates. This field
is applicable only to E-tile transceivers.

# Refclks Specify the number of reference clocks in use. If another
interface on this tile is using the same reference clock, and
you have already entered this clock in another row, enter 0
in this row to avoid double counting. This field is applicable
only to E-tile transceivers.

Refclk Frequency Specify the reference clock frequency. This field is applicable
only to E-tile transceivers.

Application Specify the application type, which determines values for
advanced channel options. Select Custom to enable manual
editing of advanced channel options for the current row.
This field is applicable only to L-tile and H-tile transceivers.

Protocol Mode Specifies the mode in which the PCS, HIP, and PCIE blocks
operate. This mode depends on the XCVR tile and the
communication protocol or standard that the channels on
this row implement.

VCCR_GXB and VCCT_GXB Voltage Specifies the voltage of the VCCR_GXB and VCCT_GXB rails.
Allowed values depend on the selected device and selected
data rate. This field is applicable only to L-tile and H-tile
transceivers.

VOD Setting The output differential voltage (VOD) setting of the
transmitter channel PMA. To enable this setting, select
Custom in the Application column. This field is applicable
only to L-tile and H-tile transceivers.

VOD Voltage The output differential voltage (VOD) of the transmitter
channel PMA (in mV). This voltage depends on the VOD
setting and the VCCT_GXB voltage. This field is applicable only
to L-tile and H-tile transceivers.

Pre-Emphasis Setting–First Pre-Tap Specifies the pre-emphasis setting used by the transmitter
channel PMA. Set to Off if the tap value is 0; otherwise, set
to On. If pre-emphasis settings are set to On, power
consumption does not depend on the magnitude nor the
sign (positive or negative) of individual taps. To enable
these settings, select Custom in the Application column.

Pre-Emphasis Setting–First Post-Tap

DFE Specify mode of the decision feedback equalizer (DFE).
Allowed values depend on the selected data rate. To enable
this setting, select Custom in the Application column. This
field is applicable only to L-tile and H-tile transceivers.

Adaptation Specify if the adaptation feature is used. This option should
be enabled if the channels use either CTLE adaptation or
DFE adaptation. To enable this setting, select Custom in
the Application column. This field is applicable only to L-
tile and H-tile transceivers.
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Column Heading Description

Transmitter High-Speed Compensation Specifies if the power distribution network (PDN) induced
inter-symbol interference (ISI) compensation is enabled in
the TX driver. To enable this setting, select Custom in the
Application column. This field is applicable only to L-tile
and H-tile transceivers.

Digital Power (W) For L-tile and H-tile transceivers, the total power of the
transmitter channel PCS, receiver channel PCS, and
Embedded Multi-die Interconnect Bridge (EMIB) blocks used
by all channels on this row (in W). This power excludes
power of PCI Express Hard IP blocks, which may be shared
among channels in multiple rows.
For E-tile transceivers, the total power of the Forward Error
Correction (FEC), Ethernet Hard IP (EHIP), and Embedded
Multi-die Interconnect Bridge (EMIB) blocks used by all
channels on this row (in W).

Analog Power (W) The total power of all analog circuitry on this row (in Watts).
This power excludes the power of PCS, FEC, EHIP, and
Embedded Multi-die Interconnect Bridge (EMIB) blocks,
whose power is provided in the Digital Power column, and L-
tile and H-tile transmitter PLLs, whose power is provided on
the PLL worksheet.
This power also excludes the power of blocks such as PCI
Express Hard IP, clock network, and other blocks that may
be shared among channels in multiple rows.

User Comments Enter any comments. This is an optional entry.

For more information about the transceiver architecture of the supported device
families, refer to the appropriate Transceiver PHY User Guide for Intel Stratix 10
devices.

Related Information

• E-Tile Transceiver PHY User Guide

• Intel Stratix 10 L- and H-Tile Transceiver PHY User Guide

4.11. Intel Stratix 10 EPE - HPS Worksheet

The HPS worksheet of the Early Power Estimator for Intel Stratix 10 devices applies to
Intel Stratix 10 devices with HPS.

To enable parameter entry into the HPS worksheet, first turn ON the HPS System
Switch in the HPS worksheet. For Intel Stratix 10 devices, select your peripheral
modules in the I/O-IP worksheet.
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Figure 19. HPS Worksheet of the Early Power Estimator

Table 15. Input Parameter Information

Input Parameter Description

HPS System Switch Turns the HPS system on or off. This selection affects the
static power.

Total HPS Power (W) Specifies the total power dissipated by the active processors
(in W).

VCCL_HPS Voltage (mV) Specifies the core HPS voltage (in mV).

Table 16. General Settings in the HPS Worksheet

Setting Description

Power Rails The name of the specific power rail.

Voltage (V) The voltage applied to the specified power rail (in V).

Standby Current (A) The standby current drawn from the specified power rail (in
A).

Dynamic Current (A) Component of active current drawn from the specified
power rail due to signal activity of all modules on this
worksheet (in A). This current is independent of device size,
device grade, power characteristics and junction
temperature.
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Table 17. HPS Worksheet Information

Module Parameters Description

CPU Frequency (MHz) Specifies the operating frequency of all CPUs (in MHz).

Application Select a benchmark application representative of the application to
run on the CPUs.

Number of Cores Specifies the number of cores in the CPU.

4.12. Intel Stratix 10 EPE - HBM Worksheet

The HBM worksheet shows the power information pertaining to high-bandwidth
memory (HBM).

Figure 20. HBM Worksheet of the Early Power Estimator

Table 18. General Settings in the HBM Worksheet

Input Parameter Description

Total Thermal Power The total power dissipated in all modules on this worksheet
(in W).

Power Rails The name of the specific power rail.

Voltage (V) The voltage applied to the specified power rail (in V).
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Input Parameter Description

Dynamic Current (A) Component of active current drawn from the specified
power rail due to signal activity of all modules on this
worksheet (in A). This current is independent of device size,
device grade, power characteristics and junction
temperature.

Memory Frequency (MHz) - HBM TOP_0 The memory interface frequency for HBM TOP_0 (in MHz).

Memory Frequency (MHz) - HBM BOT_0 The memory interface frequency for HBM BOT_0 (in MHz).

Table 19. HBM Worksheet Information

Column Heading Description

Module A user-editable field to name each module of the design.

HBM ID Select the HBM die from the list of available HBM dies in the
package.

Channel Select the channel from the list of available channels in the
HBM die.

Traffic pattern of PS-CH0 The traffic pattern of the first pseudo channel of the
channel. Select the closest pattern to your application.

Traffic pattern of PS-CH1 The traffic pattern of the second pseudo channel of the
channel. Select the closest pattern to your application.

4.13. Intel Stratix 10 EPE - Thermal Worksheet

The Thermal worksheet of the Early Power Estimator (EPE) for Intel Stratix 10 devices
allows you to enter temperature requirements for your design and displays thermal
power and thermal analysis information.

To enable thermal calculations, you must select one of the devices that support
thermal calculations, on the Main worksheet. Also on the Main worksheet, you must
set Power Characteristics to Maximum, and Junction Temp Mode to Detailed
Thermal Model.
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Figure 21. Intel Stratix 10 EPE Thermal Worksheet

Table 20. Input Parameter Information

Parameter Description

Calculation Mode Specifies the calculation mode for the thermal solver to use. Only
one calculation mode is currently supported, which determines the
cooling solution required to not exceed the specified maximum
junction temperature TJ.
Note: To enable the Thermal worksheet, set the Junction Temp

Mode on the Main worksheet to Detailed Thermal Model.

Apply Recommended Margin Specifies whether to apply recommended margins to power
estimates for thermal analysis. Recommended margins are based
on power model maturity, as follows:
• All power components: 25%
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Parameter Description

These margins apply only to thermal analysis results. Selecting
Yes causes the total power to be higher on the Thermal worksheet
than power reported elsewhere in the Early Power Estimator.

Ambient Temp, TA (°C) Specify the temperature of the air that is cooling the device.

Max. Junction Temp, TJ-MAX (°C) Specify the maximum junction temperature that no part of any die
in the package should exceed.

Table 21. Outputs of the Thermal Solver

Parameter Description

Family Specifies the device family selected on the Main worksheet.

Device Specifies the device selected on the Main worksheet.

Device Grade Specifies the device grade selected on the Main worksheet.

Package Specifies the device package selected on the Main worksheet.

Transceiver Grade Specifies the transceiver grade selected on the Main worksheet.

The fields of the following table provide thermal parameters when junction
temperature of at least one part of one of the dies is at the specified maximum
junction temperature, provided that such a scenario is achievable using reasonable
cooling solutions, given specified ambient temperature and power consumption of the
design. In a typical case other dies in the package may be at a temperature lower
than the specified maximum. The Early Power Estimator takes this into account when
reporting power and other parameters. If the specified ambient and maximum
junction temperatures are such that no reasonable cooling solution can satisfy the
requirements, the EPE produces the following error on the Thermal worksheet:
ERROR: Could not find a valid cooling solution for specified input parameters. If this
error occurs, enter more realistic ambient and maximum junction temperatures given
the power consumption of your design

Table 22. Thermal Parameters When at Least One Part of One Die is at the Specified
Maximum Junction Temperature

Parameter Description

Recommended ΨCA(°C/W) ψCA is the thermal resistance between the center of the package
integrated heat spreader (IHS) and ambient temperature. The
recommended ΨCA is the highest possible thermal resistance of
the cooling solution that ensures no part of any die exceeds the
specified maximum junction temperature.

Max. ΨJC(°C/W) ψJC is the thermal resistance between each of the dies in the
package and the center of the package integrated heat spreader.
This field shows the maximum ΨJC among all dies, assuming the
recommended ΨCA value above.

Case Temperature TCASE (°C) The case temperature, which is the temperature at the top
center of the integrated heat spreader, assuming the
recommended ΨCA value listed above.

FPGA Core Power (W) The total power consumption of the main FPGA die containing
core logic, assuming the recommended ΨCA value. This power is
reported at the actual temperature of the core die, assuming the
recommended ΨCA value. This temperature may be equal to the
maximum junction temperature if the FPGA core die is at the
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Parameter Description

highest temperature among all dies (also known as a hot spot).
The FPGA core may also be at a lower temperature, if the hot
spot is elsewhere in the package (i.e. on another die).

Transceiver Thermal power (W) The total power consumption of each transceiver die, assuming
the recommended ΨCA value. This power is reported at the
actual temperature of the specific die, assuming the
recommended ΨCA value above. This temperature may be equal
to the maximum junction temperature if a specific die is the hot
spot, or it may be at a lower temperature if the hot spot is
elsewhere in the package.
Note: Each transceiver die in the package reports a small

amount of static power even when no channels are used
in the corresponding transceiver tile and transceiver rails
(VCCR_GXB, VCCT_GXB, and VCCH_GXB) of that tile are
grounded. This is an expected result.

HBM Thermal Power (W) The total power consumption of each HBM die, assuming the
recommended ΨCA value.
This power is reported at the actual temperature of the specific
die, assuming the recommended ΨCA value above.
This temperature may be equal to the maximum junction
temperature if a specific die is the hot spot, or it may be at a
lower temperature if the hot spot is elsewhere in the package.

FPGA Core ψJC(°C/W) The thermal resistance between the main FPGA core die and the
center of the package integrated heat spreader, assuming the
recommended ΨCA value.

Transceiver Die ψJC(°C/W) The thermal resistance between each transceiver die and the
center of the package integrated heat spreader, assuming the
recommended ΨCA value.

HBM Die ψJC(°C/W) The thermal resistance between each HBM die and the center of
the package integrated heat spreader, assuming the
recommended ΨCA value.

FPGA Core TSD Offset (°C) The offset between the highest temperature (hot spot) of the
main FPGA core die and the temperature determined by reading
the temperature sensing diode (TSD) on the FPGA core die.
FPGA core temperature = FPGA core TSD temperature + FPGA
core TSD offset.

The following table shows variations of thermal parameters and power consumption
with changing junction temperature of the main FPGA core die. Three values are
provided for each parameter. The middle row contains FPGA core temperature and
other parameters assuming the recommended ΨCA value above. The top row provides
values of all parameters when FPGA core temperature is 5 degrees lower than in the
middle row. Similarly, the bottom row provides values of all parameters when FPGA
core temperature is 5 degrees higher than in the middle row. It is important to realize
that under the conditions in the last row at least one part of one die in the package
exceeds the requested maximum junction temperature, and may even exceed the
maximum allowed value for the device. Therefore the values in the last row should be
used only as an estimate of power dependence on temperature for the purpose of
computational fluid dynamic (CFD) simulation, and not for any other purpose.
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Table 23. Variation of Thermal Parameters and Power with Changes in Junction
Temperature

Parameter Description

FPGA Core Junction Temperature (°C) Shows the FPGA core die temperature for each of the three
rows, as explained above.

FPGA Core Total Power (W) Provides total power consumption of the main FPGA die
containing core logic, assuming the specific core temperature in
the given table row.

Overall Total Power (W) Provides total power consumption of all dies in the package,
assuming the specific core temperature in the given table row.

Case Temperature TCASE (°C) Provides the case temperature, assuming the specific core
temperature in the given table row.

ψCA (°C/W) Provides the thermal resistance between the center of the
package integrated heat spreader and the ambient temperature,
assuming the specific core temperature in the given table row.
For each row, this is the ΨCA value that would cause the FPGA
core junction temperature to be at the specific value for a given
row.

ψJC (°C/W) Provides the thermal resistance between each die and the center
of the package integrated heat spreader, assuming the specific
core temperature in the given table row

In extreme cases, such as thermal runaway, it may not be possible to calculate the
values for +/- 5 degrees, in which case the Thermal worksheet displays the error
message: ERROR: Could not calculate parameter variation with core temperature. Try
adjusting TJ-MAX to obtain temperature-dependent parameters. When this error occurs,
the recommended ΨCA value and all other values above are valid, but the table
showing variation of thermal parameters and power consumption with changing
junction temperature of the main FPGA core die contains some invalid values. As the
error text indicates, adjusting the maximum junction temperature may allow the
thermal solver to calculate this dependence, albeit at a different range of FPGA core
temperatures than the usual range.

For more information about thermal modeling, refer to AN-787: Thermal Modeling and
Management.

Related Information

Intel Stratix 10 EPE - Main Worksheet on page 16

4.14. Intel Stratix 10 EPE - Report Worksheet

The Report worksheet shows all the information and power estimation results from the
Early Power Estimator for Intel Stratix 10 devices.
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Figure 22. Report Worksheet of the Early Power Estimator

Table 24. Power Rail Configuration Settings in the Report Worksheet

Input Parameter Description

Power Rail Configuration Selects a power rail configuration for assignment of supply
rails to regulator groups.
This field is enabled regardless of the Power
Characteristics setting in the Main worksheet. You receive
a warning message if you select a power rail configuration
when the Power Characteristics setting is Typical.
Choose Custom to manually enter regulator group
selection, or to modify the results of automatic selection.

The Report worksheet provides current requirements for each voltage rail, expressed
in terms of static current, standby current, dynamic current, and total current.

Table 25. Current and Power Regulator Requirements Per Voltage Rail

Module Parameter Description

User Mode Current Requirement Power Supply Indicates the power supply rail
name and voltage applied to the
specified rail (in V).

Static Current (A) Indicates the component of
current consumed from the
specified power rail whenever the
power is applied to the rail,
independent of circuit activity (in

continued...   
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Module Parameter Description

A). This current is dependent on
device size, device grade, power
characteristics and junction
temperature.

Standby Current (A) Indicates the component of
active current drawn from the
specified power rail by all
modules on all worksheets,
independent of signal activity (in
A). This current is independent of
device grade, power
characteristics and junction
temperature. Standby current
includes, but is not limited to,
I/O and transceiver DC bias
current. Device size has only a
small impact on transceiver DC
bias current.

Dynamic Current (A) Indicates the component of
active current drawn from the
specified power rail due to signal
activity of all modules on all
worksheets (in A). This current
depends on device size, but is
independent of device grade,
power characteristics and
junction temperature.

Total Current Before SmartVID Savings (A) Indicates the total current
consumed from the specified
power rail before SmartVID
savings (in A). The sum of static,
standby, and dynamic currents.

Total Current (A) Indicates the total current
consumed from the specified
power rail (in A). For devices and
rails supporting SmartVID, this
column shows total current after
SmartVID power savings;
otherwise, the current reported
in this column should equal the
sum of static, standby, and
dynamic currents.

Recommended Margin Indicates the recommended
margin on total current for
regulator sizing. The
recommended margin on the Vcc
rail is calculated based on the
ratio of dynamic to static power.
Note: Recommended Margin is

reported only for devices
with final power models,
and only when the
Power Characteristics
field on the Main
worksheet is set to
Maximum.

Power Regulator Settings Regulator Group Indicates the regulator group
number to which this supply is
assigned. Regulator group
numbers correspond to the group
numbers shown in the Enpirion
worksheet. If you select an
automatic assignment mode in
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Module Parameter Description

the Power Rail Configuration
field, the regulator group
numbers also correspond to the
group numbers in the pin
connection guidelines.
To edit fields in this column
manually, select Custom under
Power Rail Configuration.

4.15. Intel Stratix 10 EPE - Intel Enpirion® Worksheet

Each row in the Regulator Selection table of the Intel Enpirion® worksheet of the Early
Power Estimator for Intel Stratix 10 devices represents the power solution for a single
regulator group.

Intel Enpirion power devices are available that satisfy the power requirements for the
power rails on FPGA devices. Power devices are selected based on load current, input
and output voltages, and power-delivery configuration.

Regulator groups are created by combining rails that can be allowably supplied from
the same source. Intel Enpirion device selection is enabled when Power
Characteristics in the Main worksheet is set to Maximum, and the Regulator
Group section of the Report worksheet is set up correctly with no grouping errors.

In the following figure, a 12-V off-line regulator supplies input power for Groups 5 and
6. The regulator for Group 6 is an intermediate supply, which does not directly power
any of the FPGA supplies, but provides input power to regulators for Groups 2, 3, and
4. The 3-V regulator supplying Group 5 provides power for FPGA supplies, but also
acts as an intermediate supply providing input power for Group 1.

Figure 23. Intel Enpirion Worksheet of the EPE Spreadsheet for Intel Stratix 10 Devices

Table 26. Intel Enpirion Worksheet Information

Column Heading Description

Group The regulator group number for this regulator. The regulator
group numbers correspond to the group numbers shown in
the Report worksheet.

Intermediate Supply Indicate whether the supply is an intermediate supply. An
intermediate supply is driven by a regulator that is not
connected to any supply rails on the FPGA. Instead, such a
regulator drives other regulators. If a regulator provides
power to both the FPGA and other regulators, this field
should be set to No.

Regulator Input Voltage (V) Specifies the input voltage for the regulator. The input
voltage must be higher than the output voltage. If this
regulator has a parent, its input voltage is automatically set
to the parent's output voltage.

continued...   
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Column Heading Description

Regulator Current Draw (A) Specifies the required input current to the regulator. It is
assumed that all regulators have a current efficiency of
85%.

Voltage (V) Specifies the output voltage of the regulator. The voltage
equals the voltage of the supply rail connected to this
regulator.

Load Current (A) Specifies the load current required by the pins from the
regulator. This current equals the sum of all the supply
currents that are connected to this regulator, multiplied by
(1 + Load Current Margin).
In addition, if this regulator is a parent of other regulators,
the Load Current also includes the sum of all the children's
input currents.

Load Current Margin Margin added to the load current to account for component
variability.

Parent Group The group number of the regulator that supplies input
voltage to the regulator in the current row. This value is
applicable only when the input voltage is provided by
another regulator on this worksheet.

Regulator Type Choose the type of the regulator.

POK Select Yes to select a regulator with a Power OK (POK)
output to assist with sequencing.

Suggested Enpirion Part Specifies suggested Intel Enpirion parts to implement
regulator for a given row, which meet the voltage and
current requirements for this row. To finalize regulator
selection, evaluate VRM voltage ripple specification and
efficiency against the FPGA device requirement from the
appropriate data sheets.

Pin Compatible Parts Pin compatible parts are devices with equivalent or higher
current capabilities that can be placed on the same PCB
footprint as the suggested Intel Enpirion part. Additional
components or changes to component values may be
required when using a pin compatible part.

Note A note may be displayed here, depending on the value
chosen under Suggested Enpirion Part.
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5. Factors Affecting the Accuracy of the Early Power
Estimator

Many factors can affect the estimated values displayed in the Early Power Estimator
(EPE) for Intel Stratix 10 spreadsheet. In particular, the input parameters entered
concerning toggle rates and temperature must be accurate to ensure that the system
is modeled correctly in the EPE spreadsheet.

Related Information

Intel Stratix 10 EPE Power Model Status on page 3

5.1. Toggle Rate

The toggle rates specified in the Early Power Estimator (EPE) for Intel Stratix 10
spreadsheet can have a large impact on the dynamic power consumption displayed. To
obtain an accurate estimate, you must input toggle rates that are realistic.
Determining realistic toggle rates requires knowing what kind of input the FPGA is
receiving and how often it toggles.

To get an accurate estimate if the design is not complete, isolate the separate modules
in the design by function, and estimate the resource usage along with the toggle rates
of the resources. The easiest way to accomplish this is to use previous designs to
estimate the toggle rates for modules with similar function.

The input data in the following figure is encoded for data transmission and has a
roughly 50% toggle rate.

Figure 24. Decoder and Encoder Block Diagram

Decoder RAM Filter Modulator Encoder

Mod Input

Data

In this case, you must estimate the following:

• Data toggle rate

• Mod Input toggle rate

• Resource estimate for the Decoder, RAM, Filter, Modulator, and Encoder module

• Toggle rate for the Decoder, RAM, Filter, Modulator, and Encoder module
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You can generate these estimates in many ways. If you used similar modules in the
past with data inputs of roughly the same toggle rates, you can use that information.
If MATLAB* simulations are available for some blocks, you can obtain the toggle rate
information from the simulations. If the HDL is available for some of the modules, you
can simulate them to obtain toggle rates.

If the HDL is complete, the best way to determine toggle rates is to simulate the
design. The accuracy of toggle rate estimates depends on the accuracy of the input
vectors. Therefore, determining whether or not the simulation coverage is high gives
you a good estimate of how accurate the toggle rate information is.

The Intel Quartus Prime software can determine toggle rates of each resource used in
the design if you provide information from simulation tools. Designs can be simulated
in many different tools and the information provided to the Intel Quartus Prime
software through a Signal Activity File (.saf) or Value Change Dump File (.vcd). The
Intel Quartus Prime Power Analyzer provides the most accurate power estimate.

5.2. Temperature

To accurately predict static power, the Early Power Estimator requires junction
temperature information for each part of the design. For best accuracy, you should use
the Thermal worksheet to perform detailed thermal modeling, followed by detailed
computational fluid dynamic (CFD) simulation of your overall system. For additional
information, refer to AN-787: Thermal Modeling and Management.
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6. Document Revision History for Early Power Estimator
for Intel Stratix 10 FPGAs User Guide

Document Version Intel Quartus
Prime Version

Changes

2021.12.03 19.2 • In the Worksheets chapter, added the Why Typical Power Might Appear
Larger than Maximum Power section to the Common Worksheet
Elements topic.

2019.07.25 19.2 • In the Intel Stratix 10 EPE - XCVR Worksheet topic:
— Updated the figure.
— In the XCVR Worksheet Information table, changed column heading

PCS/PMA Interface Width to Digital/Analog Interface Width.
— In the XCVR Worksheet Information table, added Power Mode row.
— In the XCVR Worksheet Information table, changed PCS/HIP Mode

column heading to Protocol Mode. Updated the corresponding
description.

— Modified the description for the Pre-Emphasis Setting-First Pre-Tap
and Pre-Emphasis Setting-First Post-Tap column headings.

2019.03.06 18.1 Changed the E-tile transceiver portion of the description of # of Channels
in the XCVR Worksheet Information table, in the Intel Stratix 10 EPE –
XCVR Worksheet topic.

2018.09.24 18.1 • Added link from the Download and Install the Early Power Estimator for
Intel Stratix 10 Devices topic to the Early Power Estimators and Power
Analyzer page on the Intel website.

• Added information to the description of the VCO Freq (MHz) field in the
PLL Worksheet Information table.

• Added link from the Intel Stratix 10 EPE - XCVR Worksheet topic to the
Intel Stratix 10 Transceiver PHY User Guide.

• In the HPS worksheet description, updated the image and the
descriptions in the HPS Worksheet Information table.

• In the Report worksheet description, added the Power Rail
Configuration Settings in the Report Worksheet table. Also updated the
image and added descriptions of the Recommended Margin and
Regulator Group parameters to the Current and Power Regulator
Requirements Per Voltage Rail table.

• In Appendix A. Measuring Static Power, changed occurrences of TADC
to Intel Stratix 10 Temperature Sensor IP Core.

2018.07.01 18.0 • In the Main worksheet description, updated the image. Added Total
Power Before SmartVID Savings to the Thermal Power (W)
Information table, and added a sentence to the SmartVID Power
Savings description.

• In the Logic worksheet description, modified the #Half ALMs
description and modified the # FFs description.

• In the RAM worksheet description, updated the image.
• In the I/O worksheet description, updated the image.
• In the Report worksheet description, updated the image. Added Total

Current Before SmartVID Savings (A) to the Current and Power
Regulator Requirements Per Voltage Rail table. Modified description of
Total Current (A) parameter.
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Date Version Changes

November 2017 2017.11.06 • Added Main_HBMTotalPower to the Main worksheet description.
• Replaced Bank ID with XCVR Die ID, and added PLL Type to PLL

worksheet description.
• Replaced Bank ID with XCVR Die ID, and modified descriptions of Total

Thermal Power, Analog Power, Treatment of Unused HSSI Dies,
Application, and Analog Power (W) on the XCVR worksheet.

• Modified description of Apply Recommended Margin, and added HBM
Thermal Power (W), HBM Die ΨJC (oC/W), and FPGA Core TSD
Offset (oC) on the Thermal worksheet.

• Added Intel Stratix 10 EPE - Enpirion Worksheet topic.
• Added Intel Stratix 10 EPE - HBM Worksheet topic.
• Added Power Rail Configuration and Regulator Group to the Reports

worksheet description.
• Updated the images for the Main, PLL, XCVR, HPS, Thermal, and Report

worksheets.

March 2017 2017.03.31 Initial release.
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A. Measuring Static Power
Follow these steps to measure static power in your design.

1. Verify that the device is properly configured and in user mode. (CONF_DONE,
NSTATUS, NCONFIG, and TSTPOR values should be high.)

2. Wait until a stable junction temperature (thermal equilibrium) is reached.

• Use of a thermally controlled chamber is recommended.

• You can measure the junction temperature of the FPGA using the on-chip
temperature sensing diode (TSD). Refer to your device documentation for
details on using the TSD. Alternatively, you can measure the junction
temperature with the Intel Stratix 10 Temperature Sensor IP Core, but with
reduced accuracy.

• If a thermally controlled chamber is not available, use temperature feedback
from the on-chip TSD or Intel Stratix 10 Temperature Sensor IP Core to
control a heat sink fan to achieve a desired junction temperature.

• You can also use a heat gun to achieve a desired temperature; however, this
method offers less thermal control.

3. Keep all inputs constant and do not toggle any I/Os or any clock signals (except
for the clock to the Intel Stratix 10 Temperature Sensor IP Core, if you are using
the Intel Stratix 10 Temperature Sensor IP Core to measure temperature.)

4. Depending on the board design, you can measure static current in one of several
ways:

• Use a regulator with the ability to measure voltage drop across a shunt
resistor, and query the power measurement through the power management
bus (PMBus)/system management bus (SMBus) interface.

• If a regulator with PMBus/SMBus support is not available, you can measure
the voltage drop across the shunt resistor manually for each power supply and
calculate the current from the voltage drop.

• If you use an external power supply, query the current measurement from the
power supply according to the manufacturer's specifications.

5. If you want to isolate and understand the static power component of your design's
total power consumption, take several current measurements across a range of
temperatures and record the junction temperature of each measurement. Refer to
the junction temperatures to correlate static power measurements with their
corresponding total power measurements.

6. The silicon static power measurements can be compared with the static power
estimate from the Intel Quartus Prime Power Analyzer report or the static values
shown on the Report worksheet in the EPE. Alternatively, data for your compiled
design can be imported as a .csv file, into the EPE for Intel Stratix 10 devices to
obtain static power estimates for comparison. Ensure that you set the power
characteristics in the Power Analyzer or Early Power Estimator to Maximum.
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Related Information

Intel Stratix 10 EPE - Main Worksheet on page 16

A. Measuring Static Power
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